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Manjunath Karanam
HCM Global Support Engineer
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Safe Harbor Statement

The following is intended to outline our general product direction. It is intended for
information purposes only, and may not be incorporated into any contract. It is not a
commitment to deliver any material, code, or functionality, and should not be relied upon in
making purchasing decisions. The development, release, and timing of any features or
functionality described for Oracle’s products remains at the sole discretion of Oracle.
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Agenda

> Overview of Talent Review

> Talent Review Integrations with other modules.
» Talent Review Templates

» Creating Talent Review Meeting

» Conducting Talent Review Meeting

> Talent Review Tasks and Notes

> Related Documents and FAQs.
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Talent Review

The talent review process involves one or more talent review meetings. Its purpose is to evaluate workers who are part
of the review population, assess their strengths, and address areas of risk for the organization. Use the Talent Review
work area to create, edit, and conduct talent review meetings. Using this information the organizations can create
Succession Plans for replacing the key employees.

The people involved to participate in the meeting, most often Managers, review and evaluate employee's profile,
performance, Goals, compensation, and other data and calibrate the data before and during the talent review meeting.

&
/0~ %
o -0 =
/4 el —_—
& i’ asf -
Tal,ent Review Evaluate trends Assess strengths Address areas of risk
involves
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Talent Review Process

Following Diagram shows the talent review process

(‘g‘\ HR Specialist (%\ Facilitator

Create Talent Schedule Talent
Review Template Review Meeting

o :

b

Delegate
(g %aﬁ Preparation of ~ ——* Pr%p;anrteegta a 7 Submit Data
Data? 5
Meeting
Participants l =
© Grant Access to ]
Q Other Managers?
Prepare Data 5
-f%— Coter — Submit Data
Line Managers

fg %QI 3 > panaEe Botes (%\ Facilitator

- and Tasks

Meeting
— Manage Goals gﬂ Workers

A

Conduct Talent

Review Meeting | Submit Data

Participants
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Relationship between Talent Review and other Modules

Talent review integrates with Profiles, Goals Management, and Performance Management. You
use talent review templates to control this integration.

Talent Review and Goals

A facilitator can assign a performance goal or a development goal to a worker in the review
population while conducting a Talent Review meeting. A facilitator can assign a new goal or an
existing goal from the goal library. Workers can view

the goals assigned on their performance goal or development goal pages.

Talent Review and Profiles

Reviewers rate the review population based on the ratings included in the template. When a
facilitator conducts the meeting, the participants can view the ratings of each worker in the
review population on the meeting dashboard. The

facilitator can show how the latest ratings compare with the prior ratings of the workers stored
in profiles.
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Relationship between Talent Review and other Modules

9

Talent Review and Performance Management

When a performance document is completed, the worker's profile is updated to include these
changes made in the

performance document:

- Overall ratings

- Competencies and proficiency rating levels

- Competencies and goals section ratings

When the ratings are enabled, you can configure the talent review template to include overall
worker competencies, overall ratings, and overall goals ratings
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Talent Review Stakeholders

This image shows the stakeholders of a talent review meeting.

Talent Review

=
X Facilitators

nmn

™9
.ﬁ . Participants

&)

DL MADL
“ q n n q Review Population
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Talent Review Stakeholders

This table lists what facilitators and participants do in a talent review meeting.
Stakeholder Who They Are What They Can Do Comments

* Manage and conduct the meeting.

* Add development and performance goals for
the review population.

* Create tasks for the review population.

Facilitators * Create notes about the meeting.
* Add workers in the talent review meeting
* Human resource (HR) dashboard to talent pools and succession
specialist (or other HR plans.
business partner) * Create talent pools and succession plans for | You track tasks to completion
* Organizational business leader the meeting. using the Tasks page.

Review worker profile, performance, goals,

and compensation data before the You can review worker ratings for
. meeting starts. any level of the organization. For
Participants . . . . .
* Calibrate ratings of the review example, you can review workers in
population. an organization as a single group.

* \View worker data, such as competencies and | Or, you can filter workers by job,
Line managers degrees in the worker's person spotlight. location, or other categories. E
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Talent Review Lifecycle

The talent review process includes tasks from creating the meeting template through
conducting the review meeting to managing notes and tasks created for the meeting.

12
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Talent Review Lifecycle
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Create Rating Model

My Client Group-> Profiles=> Profile Rating Models

What do you want to do or manage?

| Search for tasks 1=} |

Profile Types

Talent Profile

Item Catalogs

Model Profiles

Search Model Profiles

Profile Upgrade Mapping

Profile Rating Models

0000000
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Create Rating Model

My Client Group—> Profiles-> Profile Rating Models - Performance

Edit Rating Model

Code PERFORMANCE

Description | Rating model

*From Date ‘ 1/1/00 fo |

To Date ‘ 12/31/12 e |

Distribution Threshold ||

Rating Levels Review Points  Rating Categories  Distributions

Vieww Formatw 4 add [« Detach

“Rating Level  “Name

b ) [unatsacon

E | [inconsistently meets expectation
v 3 | [eets expectaion

v [a | [Exceed expeciation

b ] [outmn

3
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| | Save and Close | | Cancel

Description * Short Description Raﬁtl:]gr NLﬁ?{’.ﬂ; EE%E’%E or

(s & o — —
[ Intermediate | [incons | 2] | 2| [Developmi - |
| Meets expectation | [Mests | | 3] | 3| | Developm - |
| Exceed expectation | [ Exceeds | | 4 | 4] [strength -]
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Create Rating Model

My Client Group—> Profiles-> Profile Rating Models - Performance

Edit Ratillg MOdel | | Save and Close | | Cancel

Code PERFORMANCE

Description | Rating model

*From Date | 1/1/00 I"°|

To Date | 12/31/12 e |

Distbution Threshold ||

Rating Levels Review Points  Rating Categories  Distributions

View v Format » i« Detach

*Rating Level  Description Review Points mep:::smnge o poine
Unsatisfactory | 1] | o] | 1]
s R
Meets expectation ‘ 3] | 2| ‘ 3]
Exceed expectation ‘ s) [ 4] | 5]
o O i R
D Superb...Cant lose employee ‘ 1] | ] ‘ s
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Create Rating Model

Creating Rating Models:
My Client Group—> Profiles=> Profile Rating Models - Performance-> Rating Categories

Edit Rating MOdEl ‘ Save ‘ ‘ Save and Close ‘ ‘ Cancel

Code PERFORMANCE

“Nane
Description | Rating model

*From Date | 1/1/00 i |

To Date | 12/31/12 ) |

Distribution Threshold :

Rating Levels  Review Points  Rating Categories  Distributions

View v Formate & add X Delete

| SUFFICIENT | | ‘ | 21 | | 4|
| HiGH || | al | 5|
Low | ] [
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Talent Review Lifecycle

Creating Review Template.

Talent Review Lifecycle

Create Talent Review
Tem:Tate

Facilitator § | HR Specialist

Create Talent Review
MeeTng

Participants

Prepare Review
. Content

Facilitator

Faclitator

Manage Meeting Notes
and Tasks
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Create Talent Review Template

HR creates templates which facilitators can use to create talent review meetings. Facilitators can use the
same template for many meetings.

The talent review template controls these aspects of a talent review meeting:
Inclusion of matrix managers as reviewers

Maximum number of records for a meeting

Layout of the box chart that displays employee ratings

Filters that facilitators can use in a meeting

Actions that facilitators can perform

Inclusion of succession plans and talent pools

YVYVVYVY
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Create Talent Review Template

We use the below navigation to create the Review Template
- Use the Configure Talent Review Dashboard Options task in the Setup and Maintenance work area.
- Use the Search Talent Review Template quick action available in My Client Groups.

Create Talent Review Template @ IEEE

2N - 2 i b AP P G A -

*Template Name ‘ | ¥ Include Succession Plans

v
“Status ‘ Active Include talent pools

[J Include matrix managers as reviewers

Submission Process Threshold :

Owner ‘ manjunath Rao |

*Maximum Number of Records 500

4 Ratings Options @
Select a rating model for each rating. Optionally, change the display label if you want to_ If you don't want to use the rating to rate the review population, then clear the corresponding Use o Rate Review Population check box

View » = Add Remove

Use to Rate @
Rating *Display Label *Rating Model Review

Population

Mo data to display.

A Box Chart Views @
Add the rating types that appear in the box chart matrix. Select any for which the Use fo Rate Review Population check box is selected in the Ratings Options section. You can add XY views with two ratings as axes. or single ratings views. Select Submit Box Assignment for at least one X or single rating view, or one of each

View » Format w» Add Remove

Submit Box

View Name View Type X-Axis or Single Rating Y-Axis Set as Default Kssighmeit

Configure Boxes

Mo data to display.

4 Data Options @

Select the oplions that are available during the talent review.
Analytic Options.
Risk of Loss
Impact of Loss

O Mobility
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Create Talent Review Template

We use the below navigation to create the Review Template
- Use the Configure Talent Review Dashboard Options task in the Setup and Maintenance work area.
- Use the Search Talent Review Template quick action available in My Client Groups.

Talent Review Template

“Template Name ‘ Annual Review Template ¥/ Include Succession Plans
. Y/ Include talent pools
*Status ‘ Active | P
Owner Karanam, Manjunatha ¥/ Include matrix managers as reviewers
b Mceres econs W Submission Process Threshold ‘ 100 ‘
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Create Talent Review Template

The maximum number of records
The maximum number of records you specify in the template is the maximum number of
employees allowed for the review population. The default value is 500.

Include succession plans and talent pools

When creating a meeting based on the template, facilitators can add succession plans and talent pools
that they can access to the meeting. When preparing review content, reviewers can add employees to
plans and pools that they can access in the participant view of the dashboard. They can also add
succession plans and talent pools.

include matrix managers as reviewers

Your organization can ensure a comprehensive review of its employees by allowing matrix managers to
rate the performance of their dotted line reports. Matrix managers are additional managers who aren't
defined as the employee's line manager.

21 Copyright © 2023, Oracle and/or its affiliates




Create Talent Review Template

Submission Process Threshold
The submission process threshold that you specify in a Talent Review meeting template controls the
scheduling of a process used to update ratings in employee profiles.

This table indicates the effect of the submission process threshold for actions performed by a facilitator or reviewer.

Action Effect of Submission Process Threshold

Faalitator submits the meeting The submission process threshold indicates the size of the review population. For example, if you
enter 500 as the submission process threshold, when there are 500 or more employees in the review
population, a scheduled process is automatically run to update the profile ratings when the facilitator
submits the meeting.

Manager submits the ratings after The submission process threshold indicates the maximum number of employees the manager can

preparing review content rate. For example, if you enter 200 as the submission process threshold, when there are 200 or more
employees rated by the manager while preparing review content, a scheduled process is automatically
run to update the profile ratings when the manager submits the ratings.
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Create Talent Review Template

Rating Option section

4 Ratings Options @

Select a rating model for each rafing. Cpfionally, change the display label if you want fo. If you don't want fo use the rating to rale the review population,

Views < Add Remove

Rating

Potential

Overall Goals Rating

Performance

Risk of Loss

*Display Label

Potential

*Rating Model

Potential Rating Model

Overall Goals Rating

Goals Rating

Performance

Risk of Loss
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then clear the corresponding Use to Rate Review Population check box.

Use to Rate
Review
Population




Create Talent Review Template

Rating Options

In the Ratings Options section of the Talent Review template, specify the ratings that reviewers can use
to rate the review population. You can include both delivered ratings and custom ratings in a Talent
Review template. When adding ratings, we strongly recommend that you select a rating model that's
also used for the rating type in other Talent Management offerings.

Custom Ratings

If you are using Enhanced Talent Profiles, you can also include custom ratings that you create in Talent
Profiles. For example, you can create a rating to assess the innovative thinking of your employees in
Talent Profiles and select the rating in the template.
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Create Talent Review Template

Delivered Ratings
This table describes the delivered ratings that are available for including in a Talent Review template.

Ratings Description
Risk of loss Evaluate the likelihood of a person leaving the company.
Evaluate the real or perceived effects on an organization
Impact of loss when a person leaves.
Performance Evaluate a person based on their worlk.
Overall Goals Evaluate the overall goal achievement of a person.
Evaluate a person's attainable level of excellence or ability to
Potential achieve success.

Evaluate the overall competency of a person. A competency
is a combination of measurable knowledge, skills, and
Overall personal attributes that contribute to a person's
Competencies performance.
Evaluate a person's overall value to the organization using a
rating model your organization defines. You can score
workers based on factors beyond performance and
potential. These might include readiness, ability to mentor,
Talent score and learning agility.
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Create Talent Review Template

Box Chart Views

A Box Chart Views

Add the rating types that appear in the box chart matrix. Select any for which the Use to Rate Review Population check box is selected in the Ratings Options section. You can add XY views with twa ratings as axes, or single ratings views. Select Submit Box Assignment for at
least one XY or single rating view, or one of each.

Viewv Formaty 4 Add X Remove

View Name View Type X-Axis or Single Rating Y-Axis Set as Default :g:lg:n?::t Configure Boxes
Performance Vs Potential XY View v Performance : Potential : 0 /
Risk of Loss Single Rating Viie v Risk of Loss : : 0 /
Impact of Loss Single Rating Vie v Impact of Loss : : 0 /
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Create Talent Review Template

Box Chart Views

In the Box Chart Views section of the template, you add and configure the available views, using the
ratings you selected in the Ratings Options section. The rating models that you selected for the ratings
in a view determines the dimensions and number of boxes in the box chart. For example, if you map a
performance rating model with two rating categories to the X-axis, and a potential rating model with
three categories to the Y-axis, then the box chart contains six boxes (2 x 3).

View name: Enter a unique name that will let the facilitator know the use of the box chart view.
View Type: Select from the two available types:
- XY View: Uses two separate ratings as the axes
- Single Rating View: Uses one rating as the lone measure
Submit Box Assignment: When you select Submit Box Assignment for a view:
1. The labels of the boxes appear in the table view of the box chart.
2. Updates in the worker profile
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Create Talent Review Template

Box Chart Views

Configure the boxes :

For box charts of the XY View type, the number of rating categories in the rating models you selected
determines the box-chart dimensions. For example, one rating model combination might deliver a nine-box
configuration and another a six-box configuration.

For box charts of the Single Rating View type, you select the dimensions and the rating levels to populate
each box. You can select from one to five rows and columns, up to a maximum of 25 (5 x 5) boxes in the box

chart.
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Create Talent Review Template

Data Options
When creating templates for talent review meetings, you specify the data and actions available to meeting

facilitators and participants. We can classify the data options available on the meeting template page into
these categories:

- Analytic options

- Population filters

- Actions

- Color code options

Data Options

I ] 1

Analytic Population Color Code
Options Filters AcHor Options
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Create Talent Review Template

Analytic Options & Population Filters

4 Data Options @

Select the options that are available during the talent reviewe.
Analytic Options
| Risk of Loss
Impact of Loss
| Mobility

Population Filters

|:| Manager

[] reviewers and Participants
[] subordinate Level
[ Business Unit

] Department

[] sob

[ Location

1 sob Family

[] Job Function

[ crade

] Management Level

[ competency
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Create Talent Review Template

Analytic Options

When creating or editing a Talent Review meeting template, you can select the analytic options that you want
to appear on the box chart matrix. The selected analytic options appear on the box chart matrix. Facilitators
and reviewers can select up to two of these values at one time during the meeting.

Population Filters

The population filters include business unit, job, and competency. Facilitators can filter the review population using
these filters.

These population filters let you specify whom to include in the review population:

Manager: Shows all managers in the review population hierarchy, even if they have no direct reports in the
review population.

Reviewers and Participants: Shows all the direct and indirect reports of the reviewers and participants if
they're part of the review population.

Subordinate Level: Shows only the subordinates of the meeting business leader.

Management Level: Shows only people at the specified management level.

Department: Shows only members of the review population from the selected departments.
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Create Talent Review Template

Action Options
You can select the actions options shown in this table for the Actions section of the talent review dashboard

Actions

v Add Notes

v Add Task

v Add Goal

¥ Enable Holding Area

v’ Enable Organization Chart

¥ Enable Potential Assessment

Potential Assessment Questionnaire | Questionnaire v
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Create Talent Review Template

Action Options

You can select the actions options shown in this table for the Actions section of the talent review dashboard
[ Actionoptions [ wWhatitboes [ comments |

Facilitators can add notes about the meeting
or for any person in the review population.

performance or development goals from the
goal library.

Add Motes Facilitators can also manage notes created
by the worker's manager during the content
preparation phase before the talent review.
The tasks added appear in the Manage Motes
Add Task Facilitators can assign tasks to meeting and Tasks task the facilitator uses after the
participants and others. meeting to follow up on assigned tasks.
The goal management business process must
Facilitators can create goals or assign be available to create performance goals. The
Add Goal

career development business process must be
available to create development goals.

Enable Holding Area

The Holding Area displays workers without
ratings at the start of the meeting.

During the meeting, participants can move
workers to this area from the box chart. If you
don't enable the Holding Area, workers without
ratings at the start of the meeting don't appear
in the review.

Enable Compare

Participants can compare a worker with other
workers or a job profile.

You can see the Enable Compare check box
in the Actions section of the Talent Review
Template page only if the Hide Person
Compare Flow profile option's value is M.

Enable Organization Chart

Participants can view the organization chart of
the organization being reviewed.

Enable Potential Assessment

R4

Before the meeting, reviewers answer
potential assessment questions on the Prepare
Review Content page. The potential rating is
calculated automatically based on the

i S ENEY
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Create Talent Review Template

Color Code Ontions & Display Options

Color Code Options

[ Gender

1 age

] Ethnicity
1 Religion
v Job

[ Location

v Manager

- Display Options &

Select the preferred display option for each analytic and then specify the colors and shapes for each analytic value.

Risk of Loss

Preferred Display Option ~ |

Analytic Value Color to Display Shape to Display

Low [#ooeFFF || ~ | | <]
Medium [#a1e0e1 | =] | ~ ]
High | #0000FF |.| - | | ~ |
No value #BDBDCE || Diamond

Secured #8B4513 . Square
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Create Talent Review Template

Color Code Options

Use the color code options to let facilitators and participants to highlight selected segments of the review population.
Facilitators can view the average ratings for all workers within that option. For example, if a facilitator selects the
Location color code option while conducting the meeting, all workers in the review population are categorized by
location. Workers belonging to the same location are highlighted with the same color

Display Options

You can specify the display options that meeting facilitators and participants can see on the meeting
dashboard for these ratings:

« Risk of loss

« Impact of loss

« Mobility
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How to Create Review Template Product
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Good afternoon, Manjunatha Karanam!

Me My Team My Client Groups
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Create Talent Review Meeting

The talent review process involves one or more talent review meetings. Its purpose is to evaluate
workers who are part of the review population, assess their strengths, and address areas of risk for the
organization.

-
= B
= ()
Select
Mirgt?;g Select Review
Details Review 9 Participants
Content
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Create Talent Review Meeting

Select My Client Groups > Talent Review> Click on Add
Meeting Info

€ 'eeting Info

*Talent Review Meeting *Meeting Date

| | | 3/27/23 [ |
*Template Mame Data Submission Deadline

| | my/dsyy fe |
“Business Leader *Meeting Status

| | | Mot started

Organization Facilitators

| Manjunatha, Karanam |

Add Facilitator

Meeting Purpose

iew Content

D
p)
D

(3) Review Participants

(a) Population Selection
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Talent Review Meeting: Enter a name for the meeting.

Template Name: Select an existing talent review meeting template that
contains the rating models that will be used and the content that can be rated.

Business Leader: The business leader is a top manager within the organization
whose employees are to be reviewed during the meeting.

Meeting Date: This date indicates when the meeting is to start.

Data Submission Deadline: This indicates the date until when reviewers can
prepare and submit review content(worker data).

Meeting Status: By default, the meeting status is set to Not started before the
meeting. In Progress and Canceled are the other statuses that can be set.

Copyright © 2023, Oracle and/or its affiliates

o

Not started: When the meeting has not started but is scheduled for a particular

day
In progress: When the meeting has started but not yet ended

Canceled: When a scheduled meeting is canceled

Facilitators: A facilitator is an HR Specialist who conducts and manages the
meeting. By default, the person creating the meeting is added as the facilitator.
However, other facilitators can be added as well.




Create Talent Review Meeting

Review Content

After entering the meeting details, the facilitator needs to specify the values in the review content
section. These values will determine the way reviewers rate the review population.

D) Meeting Info

# Edit

° Review Content

Select Ratings for Reviewer
Talent Score

~| Risk of Loss

~| Potential

~"| Performance

~| Owverall Goals Rating

| Owverall Competencies Rating

| Impact of Loss

Succession Plans

Prior Ratings Start Date
| mASdsvy - |

Prior Ratings End Date

| musdsyy fe |

Data Validity Guideline

Plan Mame |

Talent Pools

=

There's nothing here so far.

Pool Name |

5
2
3)
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Create Talent Review Meeting

Succession Plans and Talent Pools

The facilitator can select the Succession Plans and Talent Pools that they want to discuss during the
talent review meeting. However only the pools and plans owned by the facilitator eligible to be included.
The facilitator may want to include only succession plans and talent pools that are most relevant to the
review population.

Prior Ratings Date Range

In the Prior Ratings Start Date and Prior Ratings End Date fields, indicate the date range in which you want to
retrieve prior ratings of completed meetings. Only the most recent rating in the indicated date range is
considered.
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Create Talent Review Meeting

Data Validity Guidelines
The facilitators can specify how recent worker ratings must be to be valid for the review meeting. There
are 4 options that can choose from.

' . Updated within the previous month
= -
III—I Updated within the previous 3 months
EEER= : i

EEEP’ Updated within the previous 6 months

AN
| ﬁ | . ‘ "%w ~ Updated within the previous year & -

Recent worker ratings

These ensures that the ratings later provided by the reviewers on the Prepare Review Content pages are
as recent as required. When reviewers submit their ratings, all the submitted ratings are stamped with
the submission date.
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Create Talent Review Meeting

Review Participants
In this section facilitator can select the review participants. The business leaders selected in the first step appears
automatically in the review participants list.

(D Meeting Info
(&) Review Content

® Review Participants

| Include matrix managers as reviewers

Search Tor people o

Krishnaweni, Bobbala
FAST WF DEW

KB Business leader

M esting Instructions

(4) Population Selection

Rewview Population
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Create Talent Review Meeting

Review Participants

The participants in the talent review meeting are often the managers in the organization. You can also invite
managers outside of the organization to participate. You can select at most 500 participants for a meeting.
You can also include matrix managers as meeting reviewers. To do this, select the Include matrix managers as
reviewers check box. Note that matrix managers need to have edit profile content section access security
permissions to rate their dotted line reports.

Meeting Instructions

Did you know that you can add more information or comments for reviewers in the Meeting Instructions field.
Reviewers can see the content added here on the Prepare Review Content page when they update worker ratings
before the meeting.
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Create Talent Review Meeting

Population Section
(1) Meeting Info # Edit

@ Review Content S Edit

@ Review Participants / Edit

@ ropulation Selection

Employees to Include

- |

Find in talent pool

Find by analysis

et

(5) Review Population
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Create Talent Review Meeting

Find By Criteria

The facilitator can search for workers by using the worker or manager name. Another option is to use
show filters, with which they can find workers by job, department, business unit, position, grade, email,
phone number, or location.

Find Talent Pool
The facilitator can select the talent pool to add members of the pool to the review population.
After selecting the talent pool, the facilitator can add all the members of that talent pool to the review population.

Find by Analysis

Facilitator can select the employees from the any Oracle Translational Business Intelligence (OTBI) analyses they create as
Member of review population. This gives them the ability to tailor the review population as per their needs.

An OTBI analysis is like a SQL query result. For example if there is a requirement to get a list of employees based on the
Job, position, location etc.. The facilitator can first select the analysis and then select the listed employees from the result.
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Create Talent Review Meeting

Review the Selected Employees

You can review the employees who you added to the review population in the Review Population section of the
meeting configuration page. After selecting the employees to add to the review population, click Continue to
view the Review Population section. You can remove employees who you don't want in the review population.

(1D Meeting Info
(2) Review Content
(3) Review Participants
(42 Population Selection
€ Review Population
[ISearc.'J by name O‘]
(] Sort By
Employes1, MMNR Test rzl_locl1O
I:I R rek_job10 rzk_depti10
Manjunatha, Karanam MF UK LOCATION
I:I Chlz FAST PAYROLL RT Department
1 Tesi, MMR Emp1 BAF UK LOCATION

LL FAST CORE HR RT Department i
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How to Create Review Meeting Product
Demo
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Good evening, Manjunatha Karanam!

Me My Team My Client Groups
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Talent Review Content preparation

Managers Providing rating to reports.
To prepare review content participants (reviewers) submit content for their direct and indirect reports before the
Talent review meeting is conducted. This submitted content is then reviewed in the meeting.

Talent Review Meeting Direct and Indirect reports

Preparing Review Content
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Talent Review Content preparation

Talent Review Content preparation
My Team-> Talent Review-> Talent Review Meeting—> Prepare Review Content.

( Talent Review Meetings

Meetings
‘ Search.. % show Filters Meeting Status  Not started ¥
Sort By | Meeting Name - Ato Z
KMR_TR_FY2021 Meeting on 10/08/21
Data Subrmission Status Prepare Review Content
Mot started
Grant Access
View MNotes
View Tasks
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Talent Review Content preparation

Talent Review Content preparation

Reviewers checks and updates the Employee’s ratings. When creating the meeting, facilitators and Talent Review
super users can set a due date to ensure that all the ratings are updated with in a specified period. When the
reviewer opens the Prepare Review Content page they see triangle icon next to all ratings that fall out side this
threshold. This indicates that they need to update these ratings. When they change any employee’s rating the
icon disappears.

Prepare Review Content: Organization Talent Review for FY21

Nome Marager Posential o A t Pert Goais Rating :WI :‘:." Tasent Score Modility  Notes
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Talent Review Content preparation

potential Assessment
The potential assessment questionnaire allows reviewers to rate worker potential by answering a serious of

questions rather than just selecting a rating. They select a response using either a radio button or a choice list. A
rating is calculated based on the values for the selected response. The manager can select a different rating than

the calculated value if desired.
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Talent Review Content preparation

View Dash board
To see a preview of how the data appears in the meeting box chart reviewers can click the view button. In the

reviewer view of the dash board, they can see the box chart, but only data for workers to whom that reviewer has
security access.

Filter data Add notes Add candidates Add members Crgate As§ess
succession plans readiness
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Talent Review Content preparation

View Dash board

Prepare Review Content View Dashboard | [ submit

Talent Review Meeting

Meeting Info ~

Meeting Date Data Submission Deadline
4/28/23

Ratings

| Search by employee or manager  ©,

Sort By | Name

Performance Potential Risk of Loss Impact of Loss Overall Goals Rating

Bala, Ram

Manoj Reddy
RE Reportsto Outstanding High High1 High Outstanding

Mylapuram1,
Nagaraju

Challa
Ravindranath,
ac Arvind
Reports to
Mylapuram1,
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Talent Review Content preparation

Talent Review Content preparation

Manager clicks the View button on the Content preparation page to view the dash board. Here they can see their
direct and indirect reports in the box based on the rating provided.

KMR_TR_Meeting

| Actions = Printable Page | | Save and Close | ¥ Cancel

A KA TR

=l - ER L

| Show Filters | | Performance Vs Potential —|

Evaluating Talent ©/0.00% Flexible Talent 0/0.00% Top Talent 1/33.33%

MNR Emp1, Test

High

Unproven Talent 0/0.00% Core Talent 2/66.67%

Bala, Ram Manoj Reddy MNR Test, Employes1

Medium Talent 0/0.00%

Paotertial
d

Solid Talent 0/0.00% Low Talent 0/0.00%

Low

SUFFICIENT
Performance

HIGH

Total 3 [ Select Visible Workers
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Talent Review Content preparation

Talent Review Content preparation

Manager clicks the View button on the Content preparation page to view the dash board. Here they can see their
direct and indirect reports in the box based on the rating provided.

Talent Review Meeting

Printable Page | | Save and Close | ™ | ‘ Cancel

Pt XL AR R

Select Dashboard View

[ Show Filters I [ Risk of Loss l ~ ‘

Bala, Ram Mano] Reddy

Challa Ravindranath, Arvl. Pappu, Yaswanth

last123, Employee

Risk of Loss
Total 6 [ | Select Visible Workers
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Talent Review Content preparation

Manager clicks the View button on the Content preparation page to view the dash board. Here they can see their
direct and indirect reports in the box based on the rating provided.

Talent Review Meeting

‘ Actions v ‘ ‘ Printable Page ‘ ‘ Save and Close | ¥ ‘ ‘

P S AW, .
Select Dashboard View

Show Filters | [ Impact of Loss

High 1/16.67%
Bala, Ram Mano] Reddy

Medium 2/33.33%
Challa Ravindranath, Arvl._.

Low 1/1667%
last123, Employee
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Prepare Review Content Product Demo
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Good evening, Mylapurami, Nagaraju!

Me My Team My Client Groups
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Change Photo
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Conduct Review Meeting.
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e

Conducting Talent Review Meeting

Talent Review Content preparation facilitator starts a meeting in the Talent Review work area. During the
meeting, participants, line managers provide worker Rating. The facilitator then calibrates the ratings on the
dashboard.

Talent Review work area

Participants provide
Facilitator worker ratings
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Conducting Talent Review Meeting

Participants can access the Talent Review Meeting page, where they conduct meeting task can be set up by
using the following navigation.
My Team-> Talent Review-> Talent Review Meeting—> Conduct Meeting.

Facilitators can access the Talent Review Meeting page by using the following navigation.
My Client Group—> Talent Review—> Talent Review Meeting—> Conducting Meeting.

Employees that are part of the review population appear as markers on the box chart. Facilitators and managers
can select a marker and use the move option or drag one or multiple markers to another to update employee
ratings. The markers move to the box that maps to the rating. They can also select any of the box chart views
included in the template to view the meeting.

66  Copyright © 2023, Oracle and/or its affiliates



Conducting Talent Review Meeting

Viewing the Dash Board.
The facilitator and Manager can view all employees ratings and personal information in one table and update

their ratings, as shown in the below.

Cancel

Actions ¥ Printable Page | |§aveand Close | ¥

KMR_TR_Meeting

‘Er.‘reruams | |Disp|ay'| H = ¢h B

| Show Filters | | Performance Vs Potential . |

Flexible Talent 1/16.67% Top Talent 2733.33%
Kode, Shiva MMR Emp1, Test

Evaluating Talent 0/0.00%
Pragna, Reddy

High

Unproven Talent 0 70.00% Core Talent 2/33.33% Medium Talent 0/0.00%
Bala, Ram Manoj Reddy MNR Test , Employeet

Pot ential
Medium

Solid Talent 1/16.67% Low Talent 0/0.00%

K, Shiva

LOW SUFFICIENT HIGH
Performance
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Conducting Talent Review Meeting

Dash Board actions.
The following dashboard actions helps facilitators and managers easily manage the review population.

show Details

Opens the person spotlight page where
you can see worker employment, profile,
and other details.

View Analytics

Opens the View Analytics page where
you can see more worker details from the
analyses that are configured to appear in
the meeting.

Print Profile

Opens the print dialog box where you can
select the profile information you want to
print to PDF.

If you move workers from one box to

Adds a note for a selected worker.

Mowve Mowves selected workers within the box another in the box chart matrix, you're
chart matrix or to the Holding Area. prompted to update their ratings.

Add Task Adds a task for a selected worker. Use the Tasks page to view the task.
Depending on the note visibility you
select, the note may appear as feedback to

Add Mote the worker, managers, or both. To see the

note, go to the Notes page or the Prepare
Review Content page.

Add to Succession Plan

Opens a dialog box where you can select
a succession plan and add the selected
workers to it.

Add to Talent Pool

Opens a dialog box where you can select
a talent pool and add the selected workers
toit.

Add Development Goal

Adds a development goal for the selected
worker.

The worker and manager can manage
the development goal using the career
development business process.

Add Performance Goal

Adds a performance goal for the selected
worker.

The worker and manager can manage the
performance goal using the performance
goal management business process.
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Holding Area.

The number above the icon indicates the number of workers in the area. These workers are included in the

Holding Area:
- Workers who aren't rated by their managers

- Workers who are rated using nonstandard rating models
« Workers removed from the box chart during the talent review meeting

You can drag and drop workers from the Holding Area to the dashboard and back. When you submit a meeting,
the ratings of the workers in the Holding Area for that meeting are set to blank in their profiles.
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Conducting Talent Review Meeting

Enter name

View Prior Rating | '

Display ¥

sk e

Top Talent 6/ 4 849% L

2 Doyie. Kristine - =
~; Finkie. Mike

5 Keny. Stacy

@ Fenmy. Curus
A Jones. usa
€2 raler. Chad

Emerging Talent 3/ 2 42°%%
M Anderson. Betty
2 Demarco. Janice

) Copetand. Susan

Expert Talent 1/081%
Nepo. Joy
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Holding Area 82 /66 13%

@ Agrawal Adra
3 Asvarez mateo
£3 Baktard, Steve
-4 Basak. Kabir
Beoeceker, Pey
B _Berun, Plerre
Branch. Huda
Brown, Charles
# cCasumo. Ana
- Chanara. Pavan
‘ Cilaes. Aya
£\ Dogra. Aisha
f) Eden. Sue
Frank. Josian
A Sercia. Eva
F_Gazzmio. Luigl
& Goodseil. Heat
i, Suerra. Emilio

$_Anrens. Rainer
B Assia Sasha

) Baro. Eiena
-2 Bennett, Julle
A Bemara,

_$ Borg Loga

JA Brinke. Mica

& cCampbell, Luke
8 cavey. kyan

‘ Chen, Anya

£ Cochettl, Pauia
T, Duckers. Simon
M) Foster. Clauaia
A} Ganser. Sanara
] Garagner. James
& Gomez. Jose
B Gruber. Jesse
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Conducting Talent Review Meeting

Creating Succession Plans and Talent Pools

With in the box chart view facilitators and managers can view succession plans and talent pools that are
associated with the meeting when it is created. They can drag employees from the box chart to the succession
plan or talent pool. Thev can also create new succession plans and talent pools.

Facilitators and managers view
succession plans and talent pools

When the meeting is submitted, its status is changed to completed and ratings can no longer be updated.
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Conducting Talent Review Meeting

After meeting is submitted facilitators and participants can take the following action.

| Fachiator | Partcipan

View Dashboard
Add Notes

Add Employees to Succession
Plan and Talent Pools

Create New Succession Plan
and Talent Pools

Reopening Meeting

O O 000
©O O 000
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Talent Review Lifecycle

Manage Meeting Notes and Tasks.
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Talent Review Tasks and Notes

Notes:
Talent review meeting facilitators and review managers can create notes for individual workers with in the review

population. Notes that originates in the talent review meeting contain feedback and are designated as such in the
feedback dialogue box of the meeting.

o

Q00

=

Create notes Notes contain feedback

Facilitators and Review Managers
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Talent Review Tasks and Notes

Created meeting Notes while conducting the Review Meeting, will show in this page. If facilitator wants they can
create new notes for employees in this page.

( Notes: Talent Review Meeting 2023

i .0 OV ARE & o
4 Notes
Ationsw Viewe &+ B X 5 & Detach Note Text
*Name Created By Creation Date History  Last Updated Date
Eligible for the promotion as a Team Leadsr |
Bala, Ram Manaj Reddy Karanam, Manjunatha =]

Paragraphs; 1, Words: 3, Characters (with

Visibility | Managers Only
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Talent Review Tasks and Notes

Visibility Settings: Who can see notes.

75

HNotes: Test, MNR Emp1

Meed to improve functional knowladge.

Author | All

Manjunatha, Karanam 4523

Managers Cinly ’ | Create 'N'ur:l

isibility

)
pa Managen

Everyone
Managers Cnly
Managers and Test. MNR Enmgp1

Cndy Me:

Copyright © 2023, Oracle and/or its affiliates




| 3 & 4 y #
s ? & 4 "V 4 vy &y

Talent Review Tasks and Notes

Visibility Settings: Who can see notes.
Use visibility settings to manage who has access to an employee’s meeting notes. Bellow options are available.

Everyone: Any person in the organization. People who aren't participants in the meeting can view the note in the
person spotlight page.

Managers Only: Managers in the hierarchy of the worker for whom the note is created and the meeting
facilitators.

Managers and <Worker Name>: Managers in the hierarchy of the worker, the meeting facilitators, and the
worker for whom the note is created. The worker can view the note in the person spotlight.

Only Me: Only the author of the note. However, if the facilitator creates the note on the dashboard
during the actual meeting, the participants can see it when the meeting is conducted.

Only worker and me: Only the author of the note and the worker for whom the note is created.
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Talent Review Tasks and Notes

Tasks:

As a facilitator, reviewer, or a Talent Review super user, you can create, assign, and manage tasks for action items
arising from a talent review. Tasks are added to improve the performance of the employee who are under
performing, and to assign bigger responsibilities to those who are eligible for career development. Examples of
tasks are Creating training videos, conducting knowledge session and so on.
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Talent Review Tasks and Notes

Tasks:

Talent Review dashboard: Select any person in the review population and add a task. The person to whom you add
the task is automatically the Associated Worker, and the person's manager is the Assignee. But you can change this.
Tasks page: Assign a task to any person you have access to; you aren't restricted to assigning tasks to meeting
participants or the review population
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[ ety
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Towners
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Add Owners




How to Conduct the Review Meeting
Product Demo
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Good morning, Manjunatha Karanam!
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Additional Resources

« White Papers

1. Descriptive Flexfield Segments Not Displayed In Succession Plan Page After Deployment
(Doc ID 2425498.1)

2. How To Hide "View task" Option Under 3 Dots From Talent review ( My team and My Client
Group ) ? (Doc ID 2656717.1)

3. How To Add DFF In Talent Pool Responsive Page? (Doc ID 2668826.1)

4. How Security Works In Review Participants and Population Selection While Creating Talent
Review Meeting? (Doc ID 2715308.1)

5. Why Facilitator can see Employees Outside of his Data Security Access, During Conduct
Meeting? (Doc ID 25811771)

e Customer Connect Post
Customer Connect Post

« What's New Doc
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About (€) GetStarted @ Implement @) Adopt @  Videos @) Resources @)

Advance your knowledge and realize value through
Customer Success Webinars

Oracle Customer Success team is inviting you to webinars that will guide you through your
journey with Oracle Applications, to get better value from your Cloud solutions. All
sessions are LIVE and interactive, so prepare your questions and get in touch with our
Customer Success Managers. See below all upcoming LIVE sessions corresponding to
your lifecycle phase, or request to watch them On-Demand.

We recommend you to bookmark this page and revisit it frequently. Select and register to
the ones relevant to you and share the information with other interested colleagues.




For more insights...

We can schedule a dedicated, one-to-one
session with you

Send an email to julia.calin@oracle.com
with your availability and the topics you
° wish to be addressed
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Tell us how we did!
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L

Help us improve this content for you!

Please submit the Survey that will pop up
on your screen and provide any further
feedback
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